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Preface
Summary of Revisions
Items added to this document and not included in the October 2010 Estimating Manual include:

•

Information on the distribution and review of region estimates.
Includes discussion on how to distribute estimates from Scoping
through PS&E.
Specific information on the distribution of the final engineer’s estimated (FEE).

•

ODOT policy and procedure regarding the security/confidentiality of the FEE.

•

A comprehensive breakdown of Estimator group numbers.

•

Appendix E – includes a memo outlining ODOT’s policy for
managing the Engineer’s Estimate.

•

Please contact the Project Controls Office (PCO) if you require more information
on these topics, or topics not covered in the manual.

Project Controls Office
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Purpose of Manual
The purpose of the Oregon Department of Transportation Estimating Manual is to provide
guidance and a resource to understand ODOT’s construction estimating process. Estimates are
developed as early as the scoping phase of a project and are continually revised and updated
until the project incurs actual construction costs. In addition to addressing construction plan
development, which is part of the advanced plans phase, this manual will give you an
understanding of the estimating process, the final engineer’s estimate (FEE) and an overview of
the AASHTOWare project (AWP) modules.
Estimates must follow the latest version of the standard specifications for construction, which is
currently the 2018 edition of the Oregon Standard Specifications.
To accurately develop a construction cost estimate for a project, an estimator must be capable of
mentally constructing the project and then accounting for all the activities necessary to complete
it. Many of the best cost estimators are knowledgeable in both transportation design and
construction.
While estimating a project, estimators should be shielded from pressures to keep estimates
within programmed or desired budgets based on available funding. Estimators should be free
to establish what they consider to be a fair and reasonable estimate based on the scope and
schedule of the project and anticipated bidding conditions (i.e. local and global market
conditions.)
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Definitions
AWP Preconstruction (PreCon)

The AASHTOWare project module for proposals,
estimates, lettings, and awards.
PreCon is used by various roles in the Tech Centers, Project
Controls Office and ODOT’s Procurement Office –
Construction Section.

AASHTO

American Association of State Highway Transportation
Officials, provides technical services and transportationrelated policies to support states in their efforts to
efficiently and safely move people and goods.

Cost

Cost is an expense paid out. It implies an expense was
actually incurred.

FEE

Final engineer’s estimate is the final estimate used for bid
opening, evaluation, recommendation and contract award.
The FEE includes addenda between PS&E submittal and
bid opening.

FHWA

Federal Highway Administration is part of the U.S.
Department of Transportation. FHWA is in charge of
ensuring America’s roads and highways continue to be safe
and technologically up-to-date. FHWA helps states by
providing financial and technical support for constructing,
improving and preserving America’s highway system.

PCO

Project Controls Office is a unit within ODOT’s Statewide
Project Delivery Branch. It includes Pre-Letting,
Specifications, Estimating, and Quality Assurance for
Design.
PCO provides the professional conduit to assist the project
team in successfully delivering a project to bid.

OPO – CCU
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ODOT Procurement Office – Construction Section is within
the Support Services Branch and is responsible for the
advertising, bid opening, and awarding tasks for highway
construction projects for ODOT’s Procurement Office.
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Price

Generally an estimate, quote or a bid. It implies an agreedupon rate of exchange between two parties for services.

PS&E

Plans, specifications and estimate is a scheduled milestone
event wherein all elements of a project necessary for ODOT
to advertise for bid have been delivered to, and accepted as
completed by ODOT’s Project Controls Office.

PS&E Provider

The PS&E provider is the organization or business entity
providing the complete PS&E package. This may be an
ODOT region, a local agency, or a private consulting firm.
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The Role of the Project Controls Office
Project Controls Office (PCO) uses six main steps during the advanced stages of the estimating
process of a project.
•

•

•

Review of the PS&E package – The Pre-Letting quality assurance engineer (QAE) will
review the PS&E package to ensure that all the deliverables are complete. This is a highlevel review, checking for fatal flaws and legal sufficiency. PCO obtains the chief
engineer and FHWA approvals during the review phase.
Import estimate into PreCon – The Project Estimate Worksheet (Estimator file) from the
PS&E provider is imported into PreCon which then connects to Decision Support
Software (DSS). The database is used to generate the bid sheets, FEE, electronic bidding,
and bid reviews.
Coordinate with ODOT Budget Services and FHWA – PCO will coordinate with HPO
and FHWA to obtain approval to advertise the project. On Projects of Division Interest
(PoDI) projects, PCO will coordinate the FHWA PS&E review.

•

Pass the PS&E documents to contractor plans – PCO is responsible for passing on the
plans, special provisions, bid sheets, and advertisement to OPO – Construction
Contracting Unit. PCO writes the advertisement.

•

FEE – PCO’s estimating group performs a review of the PS&E estimate on all projects
(including local agency projects bid through ODOT) and produces the FEE. The FEE
includes any addenda that may occur during advertisement and material cost
adjustments between PS&E and bid opening.
In all cases, ODOT’s policy is to keep the FEE confidential and it is not to be disclosed
to any potential bidder in whole or in part.

•

Process addenda letters and letters of clarification – PCO provides a fatal flaw review of
the addendum letter, compiles the letter (including new bid sheets) and sends it to OPO
– Construction Contracting Unit for posting.

This information can also be found in Operational Notice PD-07.
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Estimating Methods
The critical review of any bid depends on the reliability of the estimate it is being compared to.
The Final engineer’s estimate (FEE) should reflect the amount the contracting agency considers
fair and reasonable and is willing to pay for performance of the proposed work. Underestimating causes project delay because additional funding has to be arranged to meet
additional costs. Over-estimating causes inefficient use of funds, which could be used for other
projects. There are three main methods to create an estimate: Bid based, cost based, and a
combination of the two.
Bid-Based [Type A Estimates]: This method uses historical data, unit process and quantities
from recently awarded contracts to form an estimate. This approach is a cost-effective method
to develop the final engineer’s estimate. However, solely relying on historical data may not be
appropriate when the data is based on a non-competitive bidding environment because the
phasing and staging of the project doesn’t reflect the existing data and the unique composition
of the work to be completed. Under this approach, bid data is summarized and adjusted for
project conditions (i.e., project location, size, quantities, etc.) and the general market conditions.
This method requires the least amount of time and personnel to develop and produce an
adequate estimate to use in bidding/programming as long as competitive bid processes are
used. Non-competitive and unbalanced bidding practices are the least recognizable using this
method.
Cost-Based [Type B Estimates]: The actual cost method takes into consideration factors related
to performance of the work (i.e., the current cost of labor, equipment, materials, sequence of
operations, production rates, and a reasonable value of overhead and profit.) This method
requires the estimator to have a good working knowledge of construction methods and
equipment. The estimator should have resources available for determining production rates
from actual work performed by the contracting industry on similar types of projects, as well as
resources for determining current construction methods and equipment. While adjustments for
current market conditions may be required, this method typically produces an accurate estimate
and is useful in the bid aiding the decision to award or reject the project. This method is more
time-consuming and may not be practical for all projects. Please see page 27 below for
standards relating to cost based estimating.
Combination: This method combines the use of the bid-based and cost-based methods. With
this method, ODOT knows the potential bidders, market trends and construction methods.
Most projects contain a small number of items that together comprise a significant portion (i.e.
75 percent) of the total cost. The major contract items may include Portland Cement, concrete
April 2020
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pavement, structural concrete, structural steel, asphalt concrete pavement, embankment, or
other major items or work within the contract. ODOT collects information related to local
market prices of materials from materials and equipment manufacturers, dealers, and rental
companies to obtain current cost information on a regular basis. The remaining items are
estimated based on historical prices and adjusted as appropriate for the specific project.

Final Engineering Estimate
Project Controls Office performs a review of the PS&E estimate on all projects that are received
from the PS&E provider (including local agency projects bid through ODOT), and produces the
final engineering estimate (FEE). The FEE is produced by having the reviewing estimator make
adjustments to unit costs on the PS&E estimate.
Generally, this means that the PS&E estimate is only being adjusted for pricing for active
market trends, location etc. PCO does not completely redo the estimate, rather PCO simply
assures that it is accurate and up-to-date with all the current prices. The FEE includes any
addenda that may occur during advertisement and material cost adjustments that account for
economic market changes on items such as asphalt and steel between PS&E and bid opening.
ODOT’s FEEs are adjusted three times as follows:
1. After it is received for final review.
2. One week before bid for addendums and further adjustments.
3. Just before the bid date when oil and steel prices move dramatically in the bids the prior
week.
Upon completion of the FEEs, the cost estimator will send the transportation project manager
(TPMs), resident engineers consultant projects (RECP) and the construction resident engineer
(RE) (only on projects with construction engineering done by ODOT) a brief summary showing
differences between the PS&E estimate and the FEEs for the major components. This includes
major biddable items, construction engineering, anticipated items and the total price.

Security / Confidentiality of FEE
Nationwide, there are many different beliefs on whether or not to keep the FEE confidential.
FHWA addresses the FEE management in a variety of technical advisories, but ultimately defers
policy to the individual states. However, it is clear within the aforementioned technical
advisories and in conversation with FHWA staff, that they strongly prefer keeping the FEE
confidential. Oregon has no statutory requirements that control the FEE either way.
Considering this fact, it is clear that the management of the FEE is an ODOT policy decision.
Protection of the FEE is essential to maintain normal market prices and fair bid competition.
Release of the FEE exposes the value ODOT uses to compare the low bid to and the unit prices
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used to determine ODOT’s estimates. Disclosing the FEE ultimately leads to price inflation and
failed procurements on ODOT projects.
To reduce the risk of FEE confidentiality and the risk to ODOT, it is paramount that all dealings
with the FEE be conducted in close accordance with the ODOT policy.

ODOT Policy and Procedure
Policy
1. THE FINAL ENGINEER’S ESTIMATE SHALL BE CONSIDERED CONFIDENTIAL
TO ODOT. It is not to be shared with anyone other than appropriate ODOT project
development personnel, contracted consulting staff, and local agencies and their
consultants/agents. This confidentiality shall apply during all stages of project
development up to the point of formal “notice to proceed” by ODOT’s Procurement
Office.
2. This policy applies to all projects being publicly bid regardless of the method of PS&E
delivery.
3. It is not ODOT’s policy to voluntarily post or disclose in any form the FEE after contract
award to the public.
4. When requested, the release of the FEE is to be managed solely by PCO.
5. After formal contract award the FEE will be made available to non-ODOT and non-local
agency individuals and companies upon written request. This will be done on a projectto-project basis after approval to release is obtained from PCO. If a contract is not
awarded the FEE shall remain confidential.
Procedure
1. All members of a project development team (PDT) have the responsibility to maintain
the confidentiality of the project estimate from project inception through PS&E submittal
and formal contract award.
2. After PS&E Pre-Letting submittal, but before bid opening, a cost estimator within PCO
will prepare the FEE. During this process the following rules will be adhered to:
a. The estimate will be reviewed and refined by an ODOT cost estimator and will
create the FEE. If the cost estimator needs clarification regarding any of the
outsourced and local program projects, all necessary communication will be
routed through the transportation project manager (TPM.)
b. The goal of setting the FEE is to establish an estimate that is deemed to be a
“fair” value for the project to the project “owner.” The FEE considers factors such
as prior bid item cost history, project difficulty and locale, expected level of
competition, current market pricing trends, magnitude of the project, uniqueness
of the work, etc.
c. A PCO cost estimator will communicate the final total value of the FEE via
confidential email to the TPM no later than one week prior to bid opening.
April 2020
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d. It shall be the responsibility of the TPM to initiate any needed actions and/or
responses to the FEE. This includes confirmation of adequate funding if the FEE
has increased the project cost above the programmed funding amount, as well as
the desired communication regarding significant estimate changes.
e. In all cases, the ODOT senior cost estimator has the final say in establishing the
FEE.
3. Immediately after bid opening, PCO’s cost estimator will evaluate the submitted bids
following the bid evaluation and cost justification analysis. The cost estimator will
consult with others within ODOT and/or the consultant and/or the local agency, as
needed to develop their final recommendation.
4. The final estimator’s recommendation shall be communicated to the OPO – Construction
Contracting Unit (OPO – CCU) via the bid evaluation template letter. This
communication will contain confidential information and specifics regarding the FEE
and the evaluation of the bidder’s prices.
a. In the case of a recommendation to award, the OPO – CCU will initiate the
formal award process.
b. In the case of a recommendation to reject the low bid or all bids,
the OPO – CCU will seek comment from the region or local agency
regarding this decision prior to making the final determination.
c. When a case arises where the region or local agency disagrees with
the Estimating Unit recommendation, detailed FEE information may
be provided to appropriate individuals (i.e. transportation project
manager, resident engineer.)
5. The bid evaluation letter will contain recommendations regarding the
monitoring of specific items and quantities during construction. If the bid is
awarded, this information shall be forwarded by the OPO – CCU to the
appropriate resident engineer for use during project construction.

Distribution and Review of Estimates
Distribution of the FEE
Transportation project managers will be the primary distribution points for the FEE. ODOT
specification writers will also have the FEE distributed to them for projects that the ODOT
specification writers contributed on. This will allow them to use the FEE and send feedback. The
FEE will not be distributed to any non-ODOT specification writer or consultant.
Transportation project managers should primarily share the FEE with ODOT area managers
when discussing funding decisions in accordance with region policy. The FEE should not be
shared broadly or consistently with the project team, regardless of inside or outside the agency.
The official FEE developed by PCO is initially developed within a week prior to bid opening
and refined with addenda and recent commodity pricing up to bid day. There is little value and
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high risk in disclosing the FEE prior to bid opening, especially when the low bid value and
actual cost of the project will be known a few days after bid opening.
During the final phases of project development, the project team helps develop the estimate.
The estimate should never be shared, in whole or in part, outside of the immediate project team.
It should never be posted on web pages or communicated to the public or to contractors when
discussing the project. Programmed budgetary numbers from STIP are disclosed through
ODOT’s contract report and reflect a budget including the biddable items, construction
engineering, contingency, etc. If this budgetary number is discussed outside of the project team,
you should take care to note that these components are included.

Review of Estimates
The ability to use an estimate to identify scope and pricing variations is a key tool for project
teams to manage a project throughout the design phase. Each region should establish a common
procedure and practice for identifying and reviewing changes between different phases of the
project that works with region staffing and procedures.
This is accomplished by first reviewing the detailed cost estimate. The level of changes should
be focused on large scope issues, not on specific line items and should be discussed in round
values, not pennies. It is realistic to expect that unit prices and quantities change in a reasonable
manner over the course of the project. The lead designer, specifications writer, or transportation
project manager should develop expertise in this review.
Once a standard procedure is in place, the distribution of the estimate policy stated above can
be modified to include the position performing this function for the project.
PCO is available to work with the region to develop best practices for this work after a standard
procedure is in place.

Mathematically and Materially Unbalanced Bids
A mathematically unbalanced bid is a bid that contains lump sum or unit bid items that do not
reflect reasonable actual costs or a reasonable proportionate share of the bidder’s anticipated
profit, overhead costs, and other indirect costs.
A materially unbalanced bid is a bid that generates reasonable doubt that award to the bidder
(that submitted the mathematically unbalanced bid) will ultimately result in the lowest cost to
the federal government.
NOTE: A materially unbalanced bid must also be a mathematically unbalanced bid. A mathematically
unbalanced bid is not necessarily a materially unbalanced bid, however.
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A mathematically unbalanced bid shifts the profits and/or costs from one item to other items in
the bid schedule. This leaves the overall bid price competitive based on the project’s estimated
quantities.
A materially unbalanced bid recognizes a potential error in plan quantities or the potential to
manipulate quantities during construction to maximize profits. A mathematically unbalanced
unit price is then submitted on those items. The unit price bid will be high if quantities are
expected to exceed plan quantities. The unit price bid will be low if the bidder plans on underrunning quantities, otherwise not delivering or re-negotiating a price or other item replacement
strategy during construction.
There are strong incentives for contractors to use unbalanced bidding in an attempt to alter the
order of the apparent low bid, thereby receiving award of the contract. There are also risks in
that the bidder may be forced to produce precisely the estimated quantities, but these risks can
be weighed against the possibilities of negotiating price agreements and change orders during
construction.
For more information on unbalanced bids, refer to Chapter 7 of the Construction Manual.

System Does Not Update for Inflation
Estimator does not adjust or account for inflation. The catalogs that are used in conjunction with
Estimator can help alleviate this problem. These catalogs look at data from the past two years
which helps provide a more stable price structure.

Escalators
This section is for specification writers and estimators accounting for fuel, asphalt, or steel
escalation. For each project, specification writers will determine if the project will be affected by
fuel or steel escalation. They will then indicate in the specifications section which escalation
clauses to add.
ODOT has established several escalation clauses for specific commodity pricing. These clauses
help account for unforeseeable price increases that may arise during the construction phase of a
project. For example, if a contractor opts in for fuel escalation, the project receives price relief in
both directions as the commodity price fluctuates (i.e. the contractor is due money if the price of
fuel rises; the contractor owes money if the price of fuel drops.) They will then indicate in the
specifications section which escalation clauses to add.
The specification writer is encouraged to contact the senior cost estimator to discuss questions
about a specific project or circumstance.
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Fuel Escalation
The fuel escalation worksheet is on the PCO website. Specification writers use this worksheet to
determine if they need the fuel escalation clause. Instructions on how to complete the fuel
escalation worksheet are available on the PCO website.

Asphalt Escalation
To account for asphalt escalation, the estimator needs to go to PCO website where they will find
all of the current prices of asphalt. On this website, open up the most current “Monthly Asphalt
Cement Material Price” (MACMP) list. This list has the current price for asphalt for that month.
This should be used when calculating asphalt escalation.

Steel Escalation
The steel escalation worksheet is on the PCO website. Specification writers use this worksheet
to determine if they need the steel escalation clause. . Instructions for completing the steel
escalation worksheet are available on the PCO website.

Construction Schedules
The construction schedule is required as a legal document used in developing the contract
completion date. The construction schedule is created by the designer of the project or the
specification writer.
The construction schedule needs to show the bid date, completion date and the time needed to
complete major construction components of the project. Update this document when you revise
the estimate. It is highly recommended that the resident engineer review the schedule to ensure
it is achievable. The project team is responsible for keeping the official copy of the construction
schedule within ProjectWise, in accordance with ODOT’s retention schedule (typically through
completion of the project.) The schedule template is embedded in the Fuel-Index-SchedulingProgram-Zip located on the PCO website under resources.
Build the construction schedule with the following items in mind:
•
•
•
•
•

Use quantities from the project estimate downloaded from Estimator.
The schedule must be logical; the start of one activity is usually dependent on the
completion of a previous activity.
What project activities will likely run concurrently?
Review specifications Section 00290 (Work-In-Water, Noise, Environmental) limitations.
Sections 00220 (Lane Closures, Night Time – Day Time work, Festivals, Parades, etc.)
Establish schedule type (A, B, or C.)
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•
•
•

What, if any, limitations to on-site work (00180.40(b)) are appropriate?
What are flagger and/or pilot car hours?
Will winter shut-down be required? If so, how long?

Project Items
Biddable vs. Non-Biddable
Bid items for which work will be paid are considered biddable items. All other items not in the
project bid list, such as contingency, engineering, and anticipated items are non-biddable. Items
that are non- biddable are identified (and approved if required) prior to delivering the project to
PCO.

Bid Item
The Oregon standard specifications and Boiler Plate Special Provisions establish the bid items
for which work will be paid. Except for the items identified in the specification as incidental, all
work shown on the plans require bid items. Use bid items from the established Standard Bid
Item List. Use of bid items that are not on the established list will require written special
provisions, including materials, construction, measurement, and payment.
A bid item is a specific unit of work for which a price is provided in the contract. Combining
two or more existing bid items into one bid item is not recommended. Combining bid items
creates a flawed bid history for the particular bid item used and leads to highly inaccurate costs
and misinterpretation by contractors.

Lump Sum Items
Generally, using lump sum items is not recommended. Lump sum items are often used when
an item or work task can only be defined in general terms. For example, when the finished
product can be defined but not all of the components or details can easily be determined, the
use of lump sum items is acceptable. This can make estimating lump sum items difficult for the
estimator. By providing more information and breaking lump sum items into smaller
components, the greater the likelihood of developing an accurate lump sum estimate. An
estimator should define a lump sum item in terms of its simplest, most basic components and
consider other factors that are not easily estimated. By breaking up a lump sum item into
smaller sub units (which have historical data), and applying a reasonable estimating process to
those sub units, the estimator can accurately establish a price for the overall lump sum item.
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Lump sum items are divided into two categories:
a. Standard lump sum items – Standard lump sum items are identified in the Oregon
Standard Specifications and Boiler Plate Special Provisions. Use these standard lump
sum items as appropriate according to the Oregon Standard Specifications and Boiler
Plate Special Provisions. Examples include mobilization, erosion control, steel plate
girder, etc.
b. New lump sum items – New lump sum items are items not in the Oregon Standard
Specifications or Boiler Plate Special Provisions. New lump sum items are sometimes
included in project-specific specifications. Using new lump sum items is discouraged
because of higher costs to the agency when adjustments must be made to the bid item.
FHWA encourages the use of separate, non-lump sum bid items.
Using lump sum items typically transfers risk to the contractor. Contractors may raise prices to
take on this risk. Contractors cannot necessarily rely on overruns to cover work they did not
foresee. Lump sum items should only be used when the following conditions apply:
1. The lump sum item is a standard item and no appropriate alternative non-lump sum
standard item is available.
2. The work is not easily defined. The final product is known but the construction
techniques or other components are difficult to determine.
3. The work is complex with many components (the designer is encouraged to break down
lump sum items to their constituent items if possible.)
In the Estimator module a lump sum item will be shown with an “A” at the end of the item
number.

Percentages for Lump Sum Items
The following percentages were developed to show the typical percentage range for specific
items. You should decide on these percentages before the project goes into the estimating phase
and document it in the specifications for each project.
Mobilization

8.0% - Normal.
9.0% - Large earthwork projects. Large
amount of equipment needed.
10.0% - Structures.

TP&DT

April 2020

.05% - High dollar paving projects,
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1.0% - Normal.
1.5% - Several areas of work simultaneously
where TP&DT (Temporary Protection &
Direction of Traffic) is needed.
6.0 – 7.0% - Signals, camera installations.
Original prices generally come from TP&DT
designer. If the original price varies
significantly from the above percentages,
then check with the designer for verification.
Erosion Control

0.2%

Surveying

1.0 – 1.5%

Removal of Structures & Obstructions

Identify items and cost out as per sheet #2 in
the Clearing and Grubbing Worksheet.

Clearing & Grubbing

Identify number of acres and cost out as per
sheet #1 in the Clearing & Grubbing
Worksheet.

Hybrid Lump Sum Items
Hybrid lump sum items should be used when lump sum items are listed in the project
specifications. Examples of hybrid lump sum items are structural concrete, structural steel,
bridge rail, sign supports, and clearing and grubbing.
Hybrid lump sum items are very similar to regular lump sum items. Both will show a unit of
one on the bid summary sheet. With hybrid lump sum items the contractor will bid on the item
as a lump sum, but the item is entered into Estimator with a quantity and unit price. Quantities
and unit prices must be included in the estimate. Hybrid lump sum items are identified by an
“A” as the last character in the item number.

Anticipated Items
Anticipated items are used to provide a funding mechanism for non-biddable elements of work
that may be needed to complete a project. All anticipated items need to be identified and
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approved by PCO prior to submitting PS&E to PCO. The use of anticipated items is acceptable
when there is a high likelihood that non-biddable costs will be incurred.
Examples of common anticipated items include:
•
•
•
•
•
•
•
•
•
•

Statistical asphalt bonus.
Asphalt smoothness bonus.
Railroad flagging.
Asphalt escalation.
Fuel escalation.
Steel escalation.
Public information and relations.
Migratory bird monitoring.
Inflation.
Project risk.

Do not include any project work items that can be identified, quantified or designed and bid as
a common biddable item. For the occasional special item that might need to be fixed, rebuilt or
modified (not due to any contractor negligence) during the progress of the work to complete the
project, the project team can request approval for the anticipated item.
For more information on anticipated items, refer to Operational Notice PD-07 and the PS&E
Delivery Manual.

Incidental Items
Incidental items are considered minor work items necessary to complete an individual bid item
or if no bid items are included in the project, specifically identified in the Oregon Standard
Specifications.
Incidentals are minor work items necessary to complete a specific task. Incidental items are
items for which there will be no separate or additional payment. If the incidental work items or
tasks are more than three percent of the total cost of a primary bid item, a separate bid item is
required for the work item. Combining work items or tasks and making them incidental to
other work is not appropriate nor recommended. Only include the following items as incidental
when there is a small amount of this type of work on the project:
00210.90 – Mobilization.
00310.90 – Removal of Structures and Obstruction.
00320.90 – Clearing and Grubbing.
00335.90 – Blasting Methods and Protection of Excavation Backslopes.
00340.90 – Watering.
00370.90 – Finishing Roadbeds and Slopes.
00445.91 – Sanitary, Storm, Culvert, Siphon, and Irrigation Pipe.
00495.90 – Reconditioning Existing Roadway.
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00706.90 – Emulsified Asphalt Slurry Seal Surfacing.

Description of Different PreCon Modules
BAM / DDS (Decision Support System)
BAM/DDS is the software product for analysis of highway construction bid and project data.
Data passes through this core analysis module — the Decision Support System (DSS) — into its
database from the other PreCon modules. Analysis and data from DSS is passed back to a
particular module (i.e. Estimator) to provide additional functionality. Decision Support System
uses the statistical software SAS as a backbone.
Decision Support System contains a historical database specifically designed to assist in the
planning and budgeting process as well as provide decision support in bid review and
evaluation, collusion detection, vendor (contractor) analysis and item price estimation. PreCon
BAMS/DSS maintains a historical repository of contract information from all phases of the
contract lifecycle and has built-in analysis modules to support the wide variety of management
information requirements. PreCon BAMS/DSS also provides ad hoc analysis capabilities, which
allow ODOT to use the information contained in BAMS/DSS to respond to a wide variety of
executive and legislative requests.
Project Controls Office staff uses the BAM/DSS module.

Estimator [Type A Estimates]
The many aspects of Estimator will be explained in detail in the following sections. For
estimators needing a quick review on how to create an estimate in Estimator, there is a list of
basic steps in Appendix A.

Training Classes
Users of Estimator must receive training. Participants taking these classes should be using
Estimator for their jobs in scoping, PS&E, cost of components and budgeting. ODOT training is
available to local agency staff, consultants and ODOT employees.

Initial Configurations
Default Estimate Folder
To make sure that the information and the bids are saved to the correct location, complete the
following steps:
1. Select the “Global Options” from the “Tools” menu.

April 2020

Page 16

Project Controls Office
Estimating Manual
2. The “Estimate Folder” defaults to “C:\ProgramData\Estimator\Estimates.”
Save Estimator files locally until ready to upload into ProjectWise.
ESTIMATOR IS NOT COMPATIBLE WITH PROJECT WISE. USERS MUST MANUALLY
ESTIMATOR FILES FROM/TO PROJECTWISE TO ONE OF THE PC’S
DIRECTORY PATHS. D IRECT PATHS TO PROJECT WISE FAIL TO OPEN.

IMPORT/EXPORT COMPLETED

Other System Settings
Once an Estimator file is started, confirm these mandatory settings:
1. Set your “Caps Lock” on to ensure all text is in capital letters.
- Contract payments system only recognizes capital letters.
2. “Edit” > “Estimate Options”
- Select the latest current catalog, see catalog.
- Check the box next to “Only Items Codes and Rounding Levels Allowed” >
“OK.”

ODOT Staff: Configure Estimator for direct I/O with PreConstruction
Refer to instructions: Estimator – PreCon Interface Setup

Catalog
Estimator is a standalone software package specifically designed for estimating the cost of
highway construction projects. Within Estimator, the data for producing estimates is stored in
one or more catalogs which include item-related code tables and historical item prices.

ODOT Staff
For ODOT staff, follow the “User Installed Configurations” section of the Estimator FAQ
available from Project Estimator web page. Once configured, the current catalog is always
automatically available.
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Consultants
Estimator catalogs are available from the Bid History Catalogs section of Project Estimator web
page. For consultants, catalogs must be downloaded and stored locally. Catalogs are updated
periodically and it is the user’s responsibility to maintain current catalogs.
Verify Catalog Accessibility
Once your system is configured, verify that you can access the catalog.
1. Select “Tools” > “Open Catalog.”
2. A list of catalog(s) should be visible.
a. If not, call your local Estimator system administrator to verify your
configuration and/or access permissions.

Creating an Estimator File
ODOT only: Initial estimate file
Refer to instruction: Estimator – PreCon User Training
Consultants Only: Skeleton file
When preparing an estimate in Estimator, you can import a project skeleton file as the initial
step in creating an estimate. This file contains information that will help with the estimating
process. These files contain general project information and standard item groups to which you
can add items, quantities and cost estimates.
•

•
•
•

Confirm a catalog is open before importing a skeleton file, otherwise Estimator will
crash giving a “MFC” error.
o To recover, close the error windows and “Estimator” > reopen “Estimator” > open
a catalog.
In Estimator, select “File” > “Import” > into “File Name”, enter
ftp://ftp.odot.stte.or.us/techserve/estimating/Skeleton/ > click “Open.”
Select “Estimator_Skeleton.txt” > “Open.”
Check box in front of “enter new key” > “OK.”

Project Data
Once Estimator is open, and before any groups or items are added, users must
make sure that the two project data pages are filled out. Below are lists of the
fields on the two pages which need to be completed.
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Figure 1 - Estimate Page 1

A. Key: Project’s STIP key number. Type the key number here.
B. Spec year: This is the year of the specification book that you are using.
a. Field is automatically filled in by associated catalog.
C. Base date: This is the bid date for the project.
D. Unit system: The units that are used for the bid.
a. Enter “E” for the English system.
E. Latitude of midpoint/longitude of midpoint: This is the center point location of the
project. There are two ways to enter this data:
a. Enter latitude/longitude as DDMMSS format in fields with “DD.DDDD” tag.
b. Longitude is entered as a positive number, or degrees west, i.e. “123.7834”, not “123.7834.”
i. NOTE: negative longitudes will cause project to fail to upload into
PreCon.
F. Federal/state project number: Federal or state project number for the construction
engineering phase.
G. Default fund package: Ignore.
H. Description: The official project name from the STIP, originating with PCS.
a. This name must match the title on the special provisions.
I. Work type: This should be selected based on the area or work with the highest estimated
cost.
a. See Appendix B for the list of items.
J. Highway type: Select the type of highway for the project.
a. Use value from STIP.
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K. Urban/rural type: Choose the setting for where the project is located.
a. Use value from STIP.
L. Season: This should be the season when the project is completed and not when the work
is being bid.
a. Jobs over one year in duration should use the summer season.
M. County: This is the primary county where the project will be completed.
a. Use value from STIP.
N. Contingency %: This is the percentage for the contingency account.
a. This must be set to the default of 3.5%.
Figure 2 - Estimate, Page 2

A.
B.
C.
D.

Estimated by: Name of the person creating the estimate.
Checked by: Name of the person checking the estimate.
Approved by: Name of the person who approves the estimate.
Estimate type: Not currently used.

ODOT Staff: When saving estimates to ProjectWise, please use these fields as desired.
NOTE: Only as a last step, prior to directly uploading estimates from Estimator into PreCon, you must
clear all page 2 fields. The presence of any data in page 2 fields causes the upload to fail.
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Figure 3- Notes Tab in Estimate File

Notes that are entered here are used to communicate with PCO and cost estimators. Useful
information to add into the notes tab includes:
a. If there is an unusual bid item selected.
b. If incidental items are selected.
c. If further assistance will be needed at the point of document review.

Contingency Percentage
Fixed Contingency
The contingency percentage is used to account for added cost to the contract that may result
from incomplete design, unforeseen and unpredictable conditions, or uncertainties in the
project scope. It is not used to avoid making an accurate assessment of expected costs for the
given project scope. Associated General Contractors (AGC) and the Oregon Transportation
Commission (OTC) have agreed that you should include a contingency percentage of 3.5
percent of total project costs. ODOT requires the final contingency percentage to be 3.5 percent.
Reference Operational Notice PD-08 for how to request a higher contingency.
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Variable Contingency
When building estimates at earlier stages of a project (i.e. at preliminary or advance stage), it
may be warranted to use a contingency of a higher percentage to better reflect the incomplete
nature of the project at that stage.

Groups
In Estimator, a “Group” is an overall heading for related items in an estimate. An example is
“Wearing Surfaces,” which could include items such as emulsified asphalt in tack coat, level 3
½”dDense HAMC and concrete walkway, among others.

Group Numbers
Standard group numbers are:

•
•
•
•
•
•
•

Group 0200 – Temporary features and appurtenances
Group 0300 – Roadwork
Group 0400 – Drainage and sewers
Group 0500 – Bridges (further breakdown below)
o Groups 0500-0519 – Cast-in-Place Structures
o Groups 0520-0539 – Pre-Cast Structures
o Groups 0540-0549 – Cast-in-Place Retaining Walls
o Groups 0550-0559 – Steel Structures
o Groups 0560-0569 – Pre-Cast Sound Walls
o Groups 0570-0599 – Miscellaneous Structures
Group 0600 – Bases
Group 0700 – Wearing Surfaces
Group 0800 – Permanent Traffic Safety and Guidance Devices
Group 0900 – Permanent Traffic Control and Illumination Systems
Group 1000 – Right-of-Way Development and Control
Group 1100 – Water Supply Systems
Group 1200 – Added Bid Items

•

Group 9400 – Anticipated Additional Items

•

Group 9800 – Construction Engineering

•
•
•
•

Adding a Group
There are two ways to add a group:
1. Click on “Edit” > “Add Group.”
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2. Or, right click on the estimate file in the view on the left side of the screen and select
“Add Group.”
HELPFUL HINT: Once a group is created, more groups can be added by right-clicking on the
first group and then copying and pasting it.

Adding a Group Header
Click on the group to open the group information. Enter in the group number and add a short
description to identify the group. The groups should be numbered in intervals of ten. By adding
the group number and a short description, estimators will know what items are going to be
placed there. For bridges, include the bridge number in the description. Each bridge or structure
is its own group with its own set of bid items.

Bid Items
Bid items are how the contract work is paid.

Adding an Item
1. Click on the group that you want to add the bid item to.
2. Click on the space below the item number on the lower half of the screen.
3. Select the drop down arrow and search for the item from the full standard
bid item list (or begin typing the bid item code to go immediately to nearby
items.)
4. Click on the item and the item information appears on the line. Enter the
designer’s quantity on this same line.
5. Click on the next empty line and repeat the process until you have entered
all items and quantities for that group.
NOTE: The “Training” line item should only be included in the 0200 Group.

Supplemental Descriptions
Enter the supplemental bid item description. This supplemental description replaces the default
item description in bid schedules. Supplemental descriptions are required for many items.
Users will see “(Required)” next to the field when it’s required.
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Adding Unit Prices
Click on the item listed on the tree to the left or hit the green “Go” button on the line just
created above. This takes you to the detailed information for each item. This is where you add
unit price information. One or two unit prices may have already been automatically listed here;
a reference price that represents the statewide average from the current catalog and/or a bidbased unit price that represents an average regional price calculated from the current catalog.
To enter the designer’s unit price (or estimator’s unit price) follow the directions for each of the
boxes named below:
•

•

Name – Click in this box and a window opens to select a “Price Basis Type.” Select
“Reference Price” and click “OK.” Enter the unit price and type “DES” in the name box
for the designer (“EST” for estimator) who is the source of the unit price.
Active – These check boxes allow the estimator to choose which unit price to make
“active.” The active price is the one that will show in the estimate. Be sure only one box
is checked – the program will add the unit prices together if multiple boxes are checked.

Breakdown of the Item Number
The item number is a set of numbers and letters that help to describe the item. Below is an
example item number:
Example Item Number: 0225-2C00400E
• The first four numbers (0225) in the item number are the
specification number that item falls under.
• The last letter in the item number “E” shows the unit of
measure that the items is. The “E” stands for “each.”
To view what all the last letters in the item number mean, see Appendix C.

9Z9 Items
9Z9 are miscellaneous items that don’t appear on the ODOT Bid Item List. Use miscellaneous
(9Z9) bid items only in situations where no standard bid item exists. Enter the name of the item
as it appears in the special provisions into the supplemental description field. All unit price
information is manually entered for these items. These items are one-of-a-kind, non-recurring
bid items.

Hybrid Lump Sum
1. With the group highlighted, choose the appropriate hybrid lump sum item.
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2. Enter the item quantity in the quantity box.
3. Right-click and select either reference or cost sheet to price. WARNING: Do not enter
prices at the unit price level in the upper right area within the unit price box. Prices
entered here will not pass into the main system and data will be required to be re-entered
into the program.
4. Highlight the item and click on the box under the name column. It will show a window
that gives the option of creating a reference sheet or cost sheet price basis (don’t worry
about the other two options.)
5. For a lump sum item, choose the cost sheet item. Click the green “Go” button and fill
out the cost sheet.

Entering Incidental and Breakdown Data
To enter incidental and breakdown data, follow these directions:
1. Highlight the selected bid item. Right-click and select “Cost Sheet.”
2. Highlight the cost sheet descriptions in the tree view.
3. Select the “Materials” tab at the bottom of the sheet.
4. Highlight the box under the “Description” box in the lower right side of the page and
enter a description of the incidental or breakdown component of the bid item.
5. Select the box under the unit’s box and use the drop-down menu to select the unit of
measure.
6. Select the box under the quantities box and enter the quantity that is identified in the
special conditions for the work item.
7. Select the box under the “Unit-Price” box and enter the estimated unit price for the work
component.
8. Select “Enter” and repeat the process for every incidental item or breakdown item not
already listed in the unit price or cost breakdown schedule.
9. Highlight the selected bid item again and verify that all the bid components are selected.
NOTE: This will prompt an error that you should ignore.
10. Select the “Notes” tab in the upper right half of the screen. Enter the date of the
information provided in the cost breakdown, the source of the data, and the contact
person for the data.

Verify Estimate
Before saving an estimate, select the “Verify Estimate” option under the “Edit” drop-down window and
correct all errors.
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Common Mistakes
The following is a list of common mistakes made when creating an estimate. The estimator
needs to make sure the following mistakes are caught and corrected as they can have a large
effect on the overall price of the estimate.
•

For ODOT users attempting direct I/O, flat file process, into PreConstruction, negative
Longitudes prevent the estimate from uploading.

•

The wrong bid items gets picked from the Estimator Bid Item list. Always check to make
sure that you select the correct bid item.

•

The wrong catalog is used to create the estimate. Ensure you use the most current
published catalog with the updated bid item numbers and bid item descriptions of the
bid item.
The unit of measure for the bid item is incorrect.

•
•

•

•
•
•
•
•

•
•
•
•

New bid items that are not in the system are given unit prices that are inaccurate. For
new bid items, the estimator needs to choose a bid item that closely matches the new
item. Include a supplemental description that accurately describes the item. For new bid
items that are unlike any existing items, the estimator must submit a New Bid Item form.
Hybrid lump sum items are used incorrectly or not used at all. Refer to the Hybrid
Lump Sum section and the Lump Sum section for clarification. Every lump sum should
have a cost sheet to justify the cost determination of the lump sum and, if at all possible,
should be tied to a common unit of measure for that bid item. Do not just enter in “1 LS”
and a “1” as the hybrid unit.
Hybrid lump sum items often get entered with quantities of one. Make sure that all
quantities match the special provision’s estimated quantities.
Incidental Items in a project are added to the wrong bid items. Make sure that the
incidental items are added to the correct bid item.
Miscellaneous (9Z9) items are used incorrectly. They should be used only when a
standard item cannot be found to pay for the work.
With non-biddable items, the “Exclude Item from Reference Price Calculations” box is
not checked. This box has to be checked for the estimate to be accurate.
Duplicate bid items that are covered under different specifications. Designs tend to
create bid items in silos. Example: Temporary Retaining Walls, Construct and Remove
Detours, and Temporary Shoring. Each bid item in this example covers the same work.
The estimator needs to evaluate bid items for duplicate scope.
The bid item called “Construct and Remove Detours” needs to account for both the
installation and removal of detour materials.
Bid items are added with quantities beyond two or more decimal places.
The fields in Estimator are not always filled out completely.
The estimator entered incorrect percentage values for mobilization, TP&DT,
construction survey work, erosion control, and construction engineering.
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•

The estimator tries to adjust for inflation by entering funds as contingencies.
Contingency is 3.5 percent on all final estimates.

•

Relying solely on the bid history catalogs and not entering unit prices adjusted for the
specific project.
DO NOT COPY NUMBERS/PRICES FROM EXCEL AND PASTE THEM INTO
ESTIMATOR. This really throws off the estimate and can cause a lot of trouble.

•

Cost Based Estimating: [Type B Estimates]
These estimates are typically used in an independent cost estimating role or design concept for
programming large complex projects to better define the level of confidence in a TYPE A
ESTIMATE. The information below outlines the minimum requirements and standards for
producing cost based estimates. Independent cost estimating is the use of a third party
estimator to validate or inform the base cost estimate. These cost estimates are to be constructed
without bias from any other party and shall represent the cost of the work.
Format: Cost based estimates may use proprietary estimating software but must be compatible
with Heavy Bid (HCSS.) Estimates shall be required to format the output, quantities and unit
prices, into the statewide cost estimating template for comparison and quality assurance.
The following documents or reports must be submitted along with your estimate and should be
timed stamped with firm name and author of reports along with contact information:
•
•

•

•

.EST HCSS file with backup (read/write access) when using HCSS.
Cost reports
o Labor use- totals only
o Equipment by equipment – totals only
o Direct cost report
o Tax and fringe breakdown
o Fuel consumption report
Summary reports
o Estimate recap
o Chief estimators analysis
o Bide summary cost and price
o Basic bid proposal
o Risk analysis report
Estimate narrative
o Narrative outlining the basis of the cost estimate and all relative assumptions.
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Process: The following process shall be used when performing cost based estimates:
1.

Cost based estimate kickoff meeting
• TPM, RE, RECP, estimators, and consultants shall have a meeting to lay out the
scope and purpose of the estimate along with defining the Project Risk Register
and come to a documented project agreement on the following items:
o Labor rates.
o Equipment rates.
o Fuel rates.
o Labor inflation.
o Anticipated project duration.
o Site constraints.
o Environmental permitting assumptions
o Estimate bid items.
o Verify and agree to bid item quantities.
o TCP requirements and work restrictions.
o Permanent material pricing.
o Anticipated items list (not an exclusive list.)
 Fuel escalation.
 Steel escalation.
 Asphalt escalation.
 Agency furnished materials.
 Asphalt smoothness bonus.
 Public outreach.
 Utility reimbursements.
o Right of Way assumptions.
o Project risk- quantitative or qualitative.
o Anticipated general contractor FEE.
o Preliminary engineering budget.
o Construction inspection budget.
o Contingency + inflation.
These items need to be vetted by the project delivery manager, area manager, and
design team lead and in conjunction with a senior cost estimator at the Project Controls
Office. They should also be documented prior to cost estimate creation to ensure all
project teams and estimators are estimating the same project assumptions. This allows
the estimator to focus on means and methods while maintaining consistency with the
project documents. These items are just the base assumptions for the project. If they are
changed from the base assumptions, estimators will need to document the justification.
The items listed above shall be documented in Basis of Cost Estimate Narrative.
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2. The following progress meetings shall occur during development and finalization and
reconciliation of the estimates; during reconciliation the project team shall perform
quality assurance on the cost estimate and reconciling differences between the base cost
estimate and the independent cost estimate.
• 30% complete estimate.
o Discuss relative constraints.
o Ask follow up questions.
o Receive update on estimate.
o Review risk log.
o Review assumptions log.
o Change Management Request (CMR) Log
• 60% complete estimate.
o Discuss relative constraints and critical issues.
o Estimator to ask clarifying questions.
o Receive update and estimate.
o Review risk log.
o Review assumptions log.
o Change Management Request (CMR) Log
• 90% complete estimate
o Review estimate narrative.
o Review estimate by line item
o Review assumptions and contingencies.
o Review risk log.
o Review project overhead and fees.
o Change Management Request (CMR) Log
• 100% complete estimate.
o Reconcile estimates between estimators.
 Review means and methods.
 Review assumptions.
 Discuss differences.
 Ask for further information.
 Adopt the estimate.
 Change Management Request (CMR) Log

3. Structure: The following is a basic structure for creating cost based estimates:
• All bid items shall use ODOT’s current standard bid item list.
o Items can have unique bid items but must carry the ODOT bid item
number as the client number.
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•

•

April 2020

o All lump sum items shall be constructed using sub bid items called child
items. Each child item shall have defined quantities and costs relative to
that child item. These child items will roll up to the ODOT bid item, also
called the parent item.
o Unit based items can have sub bid items as well. Use the same structure
for the unit times as used in the lump sum items.
Resource Coding: Resources shall be coded in a way that allows reports to be
executed to summarize in detail each resource in the estimate. Resources shall be
defined as classes of labor, types of equipment, types of permanent materials,
types of construction materials, rented equipment, operated rental equipment,
subcontractors, and operational expenses and overhead. Coding should have the
following structure and all resources shall start with the numeric list below and
additional letters or numbers to specifically identify the resources in that
category:
o Labor 1xxxx.
o Permanent materials 2xxxx.
o Construction materials 3xxx.
o Subcontractors 4xxx.
o Operated equipment rental 5xxx.
o Un-operated equipment rental 6xxx.
o Small tools and miscellaneous supplies 7xxx.
o General conditions 9xxxx.
 Project overhead to include the following:
• Jobsite trailers.
• Jobsite utilities.
• Toilets.
• Office equipment.
• Project management vehicles.
• Taxes.
• Bond.
• Insurances.
• Permits.
• Engineering.
• Per diem.
Items that need to be considered in addition to the construction cost are the
following:
o Construction engineering/inspection.
o Right of Way cost.
o Utility reimbursements.
o Anticipated items: This list may vary by project.
 Asphalt escalation.
 Steel escalation.
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 Fuel escalation.
 Smoothness bonus.
 Agency furnished materials.
 Public outreach.
o Project contingencies.
 Design progression allowances.
 Inflation.
 Legislative changes.
 Risk based contingencies.
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Appendix A
Basic Steps to Create an Estimate
1. Open the Estimator program.
2. Set caps lock.
3. Set all mandatory parameters, including all elements required on the initial estimate
page.
4. Import the project skeleton file from
ftp://ftp.odot.state.or.us/techserv/estimating/skeleton/.
5. Expand estimate to show group categories identified in project folder.

6.
7.
8.
9.

a. Add/change/delete groups using standardized group numbers and naming
conventions.
Add the project bid items under the appropriate groups.
Add anticipated items (Group 9400.)
Add construction engineering items (Group 9800.)
Add quantities to each of the bid items.

10. Add unit prices from designer for all items.
11. Add “percent of estimate” reference prices for the Lump Sum items.
a. Mobilization.
b. TP&DT.
c. Erosion control.
d. Survey.
12.
13.
14.
15.

e. Construction engineering.
Add cost breakdowns for incidental and lump sum items in the cost sheet price basis
areas.
Add other reference price information gathered by the estimator.
Choose the final “active” price basis on analysis of all data.
Save to the appropriate ProjectWise folder.
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Appendix B
List of Options for the Work Type

ASPH – Asphalt
BASE – Base course
BRPT – Bridge painting
CONC – Concrete paving
CURB – Curb, gutters & sidewalks
DBAS – Design build – asphalt
DBMI – Design build – miscellaneous
DBST – Design build – structures
DRNG – Drainage
EROC – Erosion control
ERTH – Earthwork
FENC – Fencing
GDRL – Guardrail
GENC – General construction
HZRD – Hazardous materials disposal
ITS – Intelligent Transportation System
LSCP – Landscaping
LTNG – Lighting
MISC – Miscellaneous
PVMK – Pavement marking
RMVL – Removal of non-structures
RPRD – Rock production
SGNL – Signals
SIGN – Signs
STRC — Structures
SURF — Surface treatments
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Appendix C
List of Units of Measure in the Item Number

A = Lump sum
A = Foot or other measurement (Hybrid lump sum)
E = Each
F = Foot
J = Square yards
K = Cubic yards
L = Mile
M = Ton
O = LB
P = Gallons
Q = M gallons
R = Acre
T = Hour
U = Day
V = Week
W = Month
X = Year
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Appendix D
When an estimate is close to completion, check the following items:
•

Verify that all the bid items in the estimate match the items in the specifications.

•
•

Verify that there is a supplemental description for items that are used to
match new bid items in the specifications.
Verify that the estimate quantities match the quantities in the specifications.

•

Verify all units against the specifications.

•

Check all incidental work items to make sure they are allowed in the specifications.

•

Verify all units against the specifications.

•

Check all incidental work items to make sure they are allowed in the specifications.

•

Check for incidental work items which could be separated into separate bid items.

•

Verify that the anticipated items have been approved via signed Letter of Public Interest
Finding.
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Appendix E
Overview of AWP
AWP software is the complete, enterprise-wide software solution developed by AASHTO for
managing an agency’s construction program. It is an information system that manages the
entire contract and construction cycle, from cost estimation to proposal preparation, bid letting,
construction and material management and data collection.
ODOT Project Controls Office uses the following AWP modules:
• BAM/DSS (soon to be replaced with AWP Data Analytics)
• Estimator (soon to be replaced with AWP Estimator)
• PreConstruction
• eBids
• BidX
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AWP Models
BAM/DSS (Decision Support System)
BAM/DSS provides a complete AASHTOWare project historical data warehouse specifically
designed to provide decision support for bid monitoring and evaluation, vendor and market
analysis and item price estimation.

Estimator
Estimator is an interactive, standalone cost estimation system for transportation construction
projects that assists in the preparation of detailed estimates.

PreConstruction
PreConstruction is an online system for managing project information and automating
processes during the early phases of a construction project – including proposal preparation,
estimation, bid letting management and project award.

eBids
eBIDS allows bidders to receive proposal item schedules and submit and withdraw item bids in
a secure, electronic environment.

Bid Express
ODOT uses Bid Express (BidX) as the electronic third party bidding service for contractors to
submit bids.
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